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Ⅰ. はじめに 
本説明書はプログラマブルキーボード MKBJ24U のキー割り当て等の設定を行う専用ソフト

ウェア Matrix Maker for MKBJ24U の操作説明を記載しています。 

なお、キーボードを設定する場合には当該ソフトウェアをパソコン側にインストールする

必要がありますが、設定後のキーボードは Windows 側の汎用ドライバを使用するため、キ

ーボードを使用するパソコン側に別途ドライバ等のインストールは必要ありません。 

 

 

Ⅱ. ソフトウェアのインストールとアンインストール 

Ⅱ-1. ソフトウェアのダウンロード 

当該製品をご購入時に、弊社よりソフトウェアのダウンロード専用 URL をお送りしており

ます。お送りした URL よりインストール用ファイル(.zip)をダウンロードして下さい。 

 

Ⅱ-2. インストール 

解凍したフォルダ内には、本マニュアルとキー割り当て設定ソフト Matrix Maker for 

MKBJ24U の実行ファイルが入っています。 

以下の手順にて、インストールをして下さい。 

 

① "setup.exe"をダブルクリックすると Setup が始まり進行画面が表示されます。 

 
 

② [Welcome to the InstallShield Wizard for MKB24U]画面が表示されます。 

"Next"をクリックして下さい。 
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③その後、[License Agreement]画面が表示されます。 

"Yes"をクリックして下さい。 

 

 

④ [Customer Information]画面が表示されます。 

<User Name>と <Company Name>を任意で入力し、"Next"をクリックして下さい。 
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⑤ [Choose Destination Location]画面が表示されます。 

インストール先ディレクトリを任意に指定し"Next"をクリックして下さい。 

 

 

⑥ [Start Copying Files]画面が表示されます。 

"Next"をクリックして下さい。 

 



Matrix Maker for MKBJ24U キーボード設定ソフト説明書 

- 7 - 

⑦インストール処理の進行画面が表示されます。 

 

 

⑧ [InstallShield Wizard Complete]画面が表示されインストール処理が完了されます。 

"Finish" をクリックして下さい。 
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Ⅱ-3. アンインストール 

①{スタートメニュー -> すべてのプログラム -> KB78 -> UNINSTALL}を選択すると

[InstallShiled Wizard]画面が表示されます。"Next"をクリックして下さい。

 
 

② <Remove> を選択し"Next"をクリックして下さい。 
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③ [Confirm Uninstall]画面が表示されます。"OK"をクリックして下さい。 

 

 

④アンインストール処理の進行画面が表示されます。 

 

 

⑤ [Maintenance Complete]と表示されアンインストール処理が完了されます。"Finish"を

クリックして完了して下さい。 
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Ⅲ. キーボード設定ソフト説明 
ここでは、ソフトウェアの使用方法を記載します。 

 

Ⅲ-1. 設定ソフトの起動 

{スタートメニュー -> すべてのプログラム -> MKB24U -> MKB24U}を選択し、キーボード

設定ソフトを起動させて下さい。 

Keyboard Category 画面が表示されたら、以下の手順で操作して下さい。 

手順 1. Interface choose 欄にて、<USB>を選択 

手順 2. Available Product 欄にて、<MKB24U>を選択 

手順 3. Preview 欄にキーボードの画像が表示されたら<OK>を選択 

 

 

注意! 

 

<OK>選択後、 <Can't find The USBHID keyboard!>が表示される場合があります。これは PC が

選択したキーボードを認識していないときに表示されます。このダイアログが表示された場

合、<はい (Y)>を選択してキーボード設定ソフトを終了してから、USB 接続がきちんと接続され

ているかを確認して下さい。 

 

また、上記状態でも <いいえ (N)>を選択することで設定情報の作成を続行することは可能です。 

その場合、作成したデータは保存し、キーボードが正常に認識していることを確認したうえで

保存したデータを読み込み、キーボードへの書き込みを行って下さい。 

※キーボードが接続 /認識されていない状態での設定情報の書き込みはできません。 

手順 2 

手順 1 

手順 3 
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Ⅲ-2. 設定画面 

設定画面にて、割り当てしたいキーに対して任意のキー設定を行うキーマッピング設定と、

キーボード全般の設定を行うキーボードパラメータ設定を実施することが出来ます。それ

ら機能設定により、様々なレイアウトをカスタマイズすることができます。  

設定画面の構成は以下のとおりです。 

 

機能名 説明 

①メニューバー 基本メニューを選択できます。 

②アイコン よく使う機能をアイコンで操作できます。 

③Layer セレクト Layer 設定を行う場合に使用します。 

④キーボード割り当てキー キーマッピング設定を行うエリアです。キーボードと四角が

それぞれ同じ位置のキーに対応しています。 

⑤割当内容表示欄 マウスカーソルを乗せたキーに割り当てられている値を表

示します。 

⑥プログレスバー キーボード設定ソフトからキーボードメモリへ設定内容を

読み込み/書き込みをするときに進行状態を表示します。 

① 

② ③ 

⑤ 

④ 

⑥ 
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Ⅲ-3. 基本的なキーボード設定方法 

ここでは、 Key Code 画面の説明と、基本的なキー割り当て設定について記載します。  

 

①キーボード割り当てキーの上にマウスカーソルを乗せて、左クリックをするとメニュー

が表示されます。 <Key Code>を選択して下さい。  
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② Key Code 画面が表示されます。Key Code 画面の構成は以下のとおりです。 

 

 

① Mapping Sequence 割り当てをしたキーコード値 (Value)が 1 から順に表示されま

す。各キーで最大 450byte のメモリを保持しています。また、  

1 キーあたり最大 180 値まで登録できます。  

② Special Code ソフトウェアキーボード上にないキーをこちらより登録できま

す。日本語配列キーボード特有のキー "\"キーや "ろ "キー、また

入力遅延コマンド (Delay 0.5sec)などは Special Code から登録

をすることが可能です。  

③ Hex Code キーコードを 16 進数で直接入力して割り当てキーとして登録

をすることが可能です。  

④ Keyboard 英語 104 キー配列のソフトウェアキーボードを表示します。実

際のキーボードを押下して設定する他に、このソフトウェアキ

ーボードをクリックしてキー設定の登録をすることも可能で

す。このソフトウェアキーボードは日本語 109 キー配列とは異

なりますため、ソフトウェアキーボード上に存在しないキーは

② Special Code より選択します。  

 

① ② 

③ 

④ 



Matrix Maker for MKBJ24U キーボード設定ソフト説明書 

- 14 - 

③任意の文字列を出力するように設定します。例として 1 つのキーに ABC を割り当てます。 

画面に表示されているソフトウェアキーボード <Keyboard>にて、"A"→ "B"→ "C"の順にクリ

ックすると、 <Mapping Sequence>にクリックした順に key Code が表示されます。割り当て

の内容を確認したら"OK"をクリックします。  

 

 

④キー割り当ての行われているキーは、キーの色が深緑色になります。今回は設定した内

容は 2 文字以上 ("A"、"B"、"C")のため、キー上には "STRING"と表示されます。設定した内

容が 1 文字のみの場合、キー上には設定した 1 文字が表示されます。  
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⑤キー割り当て設定をしたキーの上にカーソルを持ってくると、キーの色が深緑色から水

色に切り替わります。また、画面下側の割当内容表示欄に割り当てたキー "<A><B><C>"と赤

文字で表示されます。  

 

 

④キーボードに設定を書き込みます。 <Update Whole keyboard アイコン ( )>をクリック

して下さい。  
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⑤キーボード書き込み状況が表示され、書き込みを終えると <Update Whole keyboard 

successful>が表示されます。 "OK"をクリックし、キーボードへの書き込みは完了します。 

 

 

⑥メモ帳等を開いて、設定したキーを 1 度押下すると設定したキー（今回は "abc"）が表十

されます。設定したキーが割り当てられているのが確認できます。  

 

 

Ⅲ-3-1. 修飾キーの使用方法とショートカットキー設定 

ショートカットキーとして使用する修飾キー（Shift キー、Alt キー、Ctrl キー、ウィン

ドウズキー）は通常のキーボードと異なり、キー押下"Down"とキー放し"Up"の 2 つのステ

イタス設定を持ちます。ソフトウェアキーボードでこれらのキーを 1 度クリックすると

"Down"、もう 1 度クリックすると"Up"が値として表示されます。 

※修飾キーは Down ステイタスのままにせず、必ず Down と Up を 1 セットにして下さい。 

 

例えば、Windows のショートカットキー Ctrl + A (すべてを選択)をキー設定する場合、

ソフトウェアキーボードを使用した設定方法は以下となります。 

手順 1. 左 Ctrl をクリック(Left Ctrl Down) 

手順 2. A をクリック(A) 

手順 3. 再度 左 Ctrl をクリック(Left Ctrl Up) 

 

上記設定は、実物のキーボードからも設定が可能です。左 Ctrl を押しながら A を押し、最

後に左 Ctrl を離すと同じ Mapping Sequence の設定となります。  
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Ⅲ-3-2. Special Codes 

Key code 画面で表示されるソフトウェアキーボードは英語 104 キー配列です。日本語配列キー

ボードにある特有キーは Special Code から登録します。英語 104 キー配列と日本語 109 キー

配列の違いは "む "、 "ろ "、 "無変換 "、 "変換 "、 "カタカナ・ひらがな "の 5 キーが無い点です。

（日本語 109 キー配列図の橙枠参照）  

 

・英語 104 キー配列図

 

・日本語 109 キー配列図 

 

設定ソフトではこれらの 5 キーを以下の様に登録できます。 

Special Codes Key Code Value 値  設定内容 

Europe1 5D 日本語キー：む 

Ro 51 日本語キー：ろ 

Muhenkan 67 日本語キー：無変換 

Henkan 64 日本語キー：変換 

Kata/Hira 13 日本語キー：カタカナ・ひらがな 

 

また、以下の特殊なキーも Special Codes から選択が可能です。 

Special Codes Key Code Value 値  設定内容 

Yen 6A 日本語キー：\ 

Delay 0.5 Sec D764 

キーを押下してから、0.5 秒遅延させてから設定

したキー情報を出力します。複数回使用すること

で遅延時間を調整することが可能です。 
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Ⅲ-3-3. Hex Code 

設定ソフト上の Keyboard や Special Codes にない値は Hex Code を入力し直接登録できま

す。Key Code 画面で表示される Value 値は USB HID to PS/2 Scan Code Translation Table

内の"PS/2 Set Make"の値です。 

参照 URL： USB HID to PS/2 Scan Code Translation Table 

http://download.microsoft.com/download/1/6/1/161ba512-40e2-4cc9-843a-923143f3456

c/translate.pdf 

 

Ⅲ-3-4. Layer セレクト 

同じキーに対して Layer（層）毎に異なる出力コードの割り当て設定ができます。Layer は

Layer0～ Layer15 まで存在し、合計で 16 層あります(Soft_Layer は使用しません)。 

 

標準は Layer0 で、Layer の切替は必要なく設定したキーが出力できます。 

Layer1～ Layer15 を使用するには、以下の設定が必要です。 

ここでは、例として左下に Layer Index（ Layer 切替キー）を割り当て、Layer セレクトの

使用方法を記載します。キーの割り当て方はⅢ-2-3-1. Key Codeを参照して下さい。 

 

① <Layer 0>であることを確認し、左上のキーに"A"、 "B"、 "C"、 "D"、 "E"、 "F"、 "G"のキ

ー設定を割り当てます。 
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②次に、Layer セレクトボックスにて<Layer 0>から<Layer1>へ切り替えると、手順①で設

定した左上キーはクリア（何も設定されていない状態）になります。この状態で、左上の

キーに"H"、 "I"、 "J"、 "K"、 "L"、 "M"、 "N"のキー設定を割り当てます。 

  

 

③左下キーの上にマウスカーソルを乗せて、左クリックをするとメニューが表示されます。

<Layer Index>を選択します。 
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④ [Layer Code]画面が表示されます。<Layer1>を選択し、"OK"をクリックして下さい。 

 

 

⑤割り当てたあと、設定キーの上にマウスカーソルを乗せると、割当内容表示欄に<layer1>

と緑文字で表示されます。 
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⑥接続しているキーボードへ設定を書き込みます。キー設定画面の<Update Whole keyboard

アイコン( )>をクリックして下さい。<Update whole keyboard successful>のダイアロ

グが表示されたら"OK"を選択してダイアログを閉じて下さい。 

 

 

⑦実際にキーボードを操作して設定の確認を行います。 

メモ帳等を開いて、以下のように動作するか確認して下さい。 

手順 1. 左上のキーを押下すると"abcdefg"が入力される 

手順 2. 左下のキーを押下しながら左上のキーを押下すると"hijklmn"が入力される 

 

 

a. 
b. 
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Ⅲ-3-5. Multiple Key 

Multiple key 設定は、倍角キー（1x2 倍、2x2 倍キー）を使用するための設定です。倍角

キーを設定する場合、ソフトウェア上の設定で、「Key Code 設定するキー（Ⅲ-3. 基本的

なキーボード設定方法参照）」と、"Multiple Key"機能を使用した「それに付随するキー」

をそれぞれ設定する必要があります。 

 

Ⅲ -3-5-1. 1x2 倍キーの割り当て方法 

1x2 倍キーの割り当て設定方法について記載します。1x2 倍キーを使用するとき、押される

キースイッチ数は 2 つになります。よって、「Key Code 設定するキー」を 1 つ、「それに

付随するキー」を 1 つ、それぞれを設定します。 

今回は、以下のキー（A）と、キー（B）を用いて説明します。 

 

A 

B 
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①「Key Code 設定するキー」のキー（A）に、任意の文字列を設定します。 

 

 

②キー（B）の上にカーソルを持ってきて、左クリックをすると Multiple key メニューが

表示されるので"Multiple key"を選択します。 
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③ Multiple key 画面が表示されます。ここでは付随割り当て設定のできます。付随設定を

するキー（B）キーがグレーアウトされていることを確認して下さい。手順①で設定したキ

ー（A）の位置のラジオボタンにチェックをつけて"OK"を選択して下さい。 

   

 

④ Multiple key 設定されたキーは色が深緑色になります。また、設定キーの上にマウスカ

ーソルを持ってくると、割当内容表示欄に<PToKeyxx>とピンク色の文字で表示されます。 
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⑤作成した設定をキーボードへ書き込みます。<Update Whole keyboard アイコン( )>を

クリックして下さい。書き込みを終えると<Update Whole keyboard successful>が表示さ

れるので、"OK"をクリックします。キーボードへ書き込みがされました。 

 

 

⑥メモ帳等を開いて設定したキーを押すと、いずれを押下しても設定したキー（今回は

"abcde"）と出力されます。キー設定が確認できましたら、設定した箇所のキートップを

1x2 倍キーへ取り替えて使用してください。 
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Ⅲ -3-5-2. 2x2 倍キーの割り当て方法 

2x2 倍キーの割り当て設定方法について記載します。2x2 倍キーを使用するとき、押される

キースイッチ数は 4 つになります。よって、「Key Code 設定するキー」を 1 つ、「それに

付随するキー」を 3 つ、それぞれを設定します。 

今回は、以下のキー（A）、キー（B）、キー（C）、キー（D）を用いて説明します。 

 

 

A 

C D 

B 



Matrix Maker for MKBJ24U キーボード設定ソフト説明書 

- 27 - 

①「Key Code 設定するキー」のキー（A）に、任意の文字列を設定します。 

 

 

②キー（B）の上にカーソルを持ってきて、左クリックをすると Multiple key メニューが

表示されるので"Multiple key"を選択します。 
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③ Multiple key 画面が表示されます。ここでは付随割り当て設定のできます。付随設定を

するキー（B）キーがグレーアウトされていることを確認して下さい。手順①で設定したキ

ー（A）の位置のラジオボタンにチェックをつけて"OK"を選択して下さい。 

    

 

④ Multiple key 設定されたキーは色が深緑色になります。また、設定キーの上にマウスカ

ーソルを持ってくると、割当内容表示欄に<PToKeyxx>とピンク色の文字で表示されます。 
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⑤今回は 2x2 倍キーの設定のため、（B）キーに引き続き（C）キー、（D）キーも同様に

Multiple key 設定を実施して下さい。 

 

 

⑥作成した設定をキーボードへ書き込みます。<Update Whole keyboard アイコン( )>を

クリックして下さい。書き込みを終えると<Update Whole keyboard successful>が表示さ

れるので、"OK"をクリックします。キーボードへ書き込みがされました。 
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⑦メモ帳等を開いて設定したキーを押すと、いずれを押下しても設定したキー（今回は

"vwxyz"）と出力されます。キー設定が確認できましたら、設定した箇所のキートップを

2x2 倍キーへ取り替えて使用してください。 

 

 

Ⅲ-3-6. ASCII Code 

割り当て設定をしたいキーの上にマウスカーソルを持ってきて、左クリックをするとメニ

ューの中に ASCII Code メニューが表示されます。 

 

ASCII Code 画面にて、ASCII コードで出力する文字をキーに割り当てることができます。

約 180 文字の文字を 1 キーに ASCII コードとして割り当てることができます（※半角英数

のみ対応）。 

設定を完了し、キーを押すと登録した文字列が出力されます。 

 

 

下記 4 種のキーも以下の表記を入力することで割り当てることができます。 

Symbol（記号) Representation（表記) 

Enter n または N (\n または \N) 

Esc e または E (\e または \E) 

Tab t または T (\t または \T) 

 もしくは \  (\\) 
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Ⅲ-3-7. Clear 

割り当て設定をしたキーの上にマウスカーソルを持ってきて、左クリックをするとメニュ

ーの中に Clear メニューが表示されます。これは設定されているキー1 つに対し、キー設

定を削除する機能です。キー設定の一部を削除するときに使用します。 

また、設定されていないキーの場合、Clear メニューはグレーアウトされています。 

 

    

キー設定されている場合   キー設定されていない場合  
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Ⅲ-3-8. キー設定の Cut、 Copy、 Paste 

キー設定をしたキーの上にマウスカーソルを持ってきて、右クリックをすると、"Cut"、

"Copy"、 "Paste"を選択できるメニューが表示されます。 

ここでは、これらのメニューについて記載します。  

 

また、キー設定されているキーでないと"Cut"、"Copy"は選択できません。キー設定をして

いないキーの場合、全てのメニューがグレーアウトされています。  

   

キー設定されている場合     キー設定されていない場合  
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Ⅲ -3-8-1. キー設定の切り取り 

キー設定したキーの情報を、別のキーに移動したい場合、右クリックメニューの"Cut"を使

用します。ここでは"Cut"について記載します。 

 

①キー設定をしたキーの上にマウスカーソルを持ってきて、右クリックをすると、"Cut"

を選択してください。 

 

 

②キーに設定していたキー設定情報が切り取られます。キー設定情報は、ソフトウェア内

で保持されています。この保持した情報を使用する場合は、右クリックメニューの"Paste"

を使用（Ⅲ-3-8-3. キー設定の貼り付け参照）します。 
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Ⅲ -3-8-2. キー設定のコピー 

キー設定したキーの情報を、別のキーにコピーしたい場合、右クリックメニューの"Copy"

を使用します。ここでは"Copy"について記載します。 

 

①キー設定をしたキーの上にマウスカーソルを持ってきて、右クリックをすると、"Copy"

を選択してください。 

 

 

②キーに設定していたキー設定情報はそのままに、キー設定情報はソフトウェア内で保持

されています。この保持した情報を使用する場合は、右クリックメニューの"Paste"を使用

（Ⅲ-3-8-3. キー設定の貼り付け参照）します。 
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Ⅲ -3-8-3. キー設定の貼り付け 

右クリックメニューの"Cut"、"Copy"を実施し、キー設定情報を保持した状態の場合にのみ、

右クリックメニューの"Paste"を使用できます。ここでは"Paste"について記載します。 

 

①キー設定をしたキーの上にマウスカーソルを持ってきて、右クリックメニュー"Cut"もし

くは"Copy"を選択してください。今回は"Copy"を選択して説明します。 

 

 

②コピー元のキー設定情報をソフトウェア内で保持した状態で、コピー先のキーの上にマ

ウスカーソルを持ってきて、右クリックメニューの"Paste"を選択してください。 
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③コピー先のキーに、保持されたキー設定が設定されます。 

 

 

④キー設定をキーボードへ書き込みます。 

書き込み終えたらメモ帳等を開き、設定したキーを押下します。コピー元のキー、コピー

先のキーいずれを押下しても設定したキー（今回は"12345"）と出力されます。 
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Ⅳ. メニューバーとアイコン 
設定画面内のメニューバーの説明と対応するアイコンです。 

大項目 小項目 説明 アイコン 

File New ->  Key Map 新規作成 - 

Open ファイルを開く 
 

Save 上書き保存 
 

Save As 名前を付けて保存 - 

Exit 終了 - 

Keyboard 
Update Whole Keyboard 

全キーマッピング設定とキーボードパ

ラメータ設定の書き込み  

Update Key Mappings 全キーマッピング設定の書き込み - 

Retrieve Keyboard 
全キーマッピング設定とキーボードパ

ラメータ設定の読み込み  

Clear Current Layer 
現在表示している Layer のキーマッピ

ング設定のみ削除 
- 

Clear All 全キーマッピング設定の削除 
 

Keyboard Setting キーボードパラメータ設定の表示 - 

Diagnostic Enter Test Mode テストモードの開始 - 

Exit Test Mode テストモードの終了 - 

Set Default Value 
キーマッピング設定とキーボードパラ

メータ設定を工場出荷時に戻す 
- 

Firmware version ファームウェアバージョンの確認 - 

Language English 英語表記に切替(default は英語表記) - 

Simplified Chinese 中国語（簡体）表記に切替 - 

Help 
About Matrix Maker マトリクスメーカーについて 
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Ⅳ-1. File 

設定情報の新規作成、展開、保存やソフトウェアの終了を選択できます。 

 

Ⅳ-1-1. New - Key Map 

新しく設定情報を作成したい場合、以下の手順を実施して下さい。Keyboard Category 画

面から遷移してきた場合、設定画面は新規作成の状態で起動します。 

 

①メニューバーから{File -> New -> KeyMap}を選択して下さい。 

※もし保存されていない設定ファイルを開いた状態だと<Are you sure to save changes>

のアラートが表示されます。[はい]を選択して設定ファイルを保存するか、[いいえ]を選

択して設定ファイルを破棄して下さい。[キャンセル]を選択すると、新規作成を取り止め

て元の画面に戻ります。 

②設定ファイルが新規作成され、未設定の画面が表示されます。 

 

Ⅳ-1-2. File - Open 

保存してある設定ファイルを読み込みたい場合、以下の手順を実施して下さい。 

 

①メニューバーから{File -> Open}を選択して下さい。 

②Matrix Maker for MKBJ24U で保存した dat ファイルを指定し、"開く"を選択して下さい。 

③読み込みを終えると<the file opened successful>のダイアログが表示されます。"OK"

を選択してダイアログを閉じて下さい。設定の反映された画面が表示されます。 

 

Ⅳ-1-3. Save/Save as 

作成した設定情報を保存したい場合、以下の手順を実施して下さい。 

 

①メニューバーから{File -> Save}または{File -> Save As}を選択して下さい。 

※[Save]は「上書き保存」、[Save As]は「名前をつけて保存」と同様の動作です。 

②任意のファイル名を入力し、任意の保存先を指定し、"保存"を選択して下さい。 

③保存を終えると<File saved successful>のダイアログが表示されます。"OK"を選択して

ダイアログを閉じて下さい。なお、ファイルは dat 形式で保存されます。 

 

Ⅳ-1-4. Exit 

キーボード設定ソフトを終了したい場合、以下の手順を実施して下さい。 

 

①メニューバーから{File -> Exit}を選択して下さい。 

※もし保存されていない設定ファイルを開いた状態だと<Are you sure to save changes>

のアラートが表示されます。[はい]を選択して設定ファイルを保存するか、[いいえ]を選

択して設定ファイルを破棄して下さい。[キャンセル]を選択すると、終了を取り止めて元

の画面に戻ります。 

※ウィンドウの右上｢×｣を選択しても同様の動作をします。 
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Ⅳ-2. Keyboard 

キーボードへの設定書き込みと、キーボードからの設定読み込み、設定情報のクリアや、

キーボードパラメータの設定が出来ます。 

 

Ⅳ-2-1. Update Whole Keyboard 

キーボード設定には、キーマッピング設定とキーボードパラメータ設定の 2 つがあります。

全キーボード設定の書き込みでは、この 2 つの設定をキーボードへ書き込みます。 

 

①メニューバーから{Keyboard -> Update Whole Keyboard}を選択して下さい。選択すると、

プログレスバーが進みます。 

②書き込み終えると<Update whole keyboard successful>のダイアログが表示されます。

設定がキーボードへ書き込まれましたので、"OK"を選択してダイアログを閉じて下さい。 

 

Ⅳ-2-2. Update Key Mappings 

全キーマッピングの書き込みでは、キーマッピング設定のみキーボードへ書き込みます。 

※キーボードパラメータ設定は書き込まれません。 

 

①メニューバーから{Keyboard -> Update Key Mappings}を選択して下さい。選択すると、

プログレスバーが進みます。 

②書き込み終えると<Update Key Mappings successful>のダイアログが表示されます。設

定がキーボードへ書き込まれましたので、"OK"を選択してダイアログを閉じて下さい。 

 

Ⅳ-2-3. Retrieve Keyboard 

現在接続されているキーボードに設定されているキーマッピング設定とキーボードパラメ

ータ設定を、ソフトウェア上に読み込みます。 

 

①メニューバーから{Keyboard -> Retrieve Keyboard}を選択して下さい。選択すると、プ

ログレスバーが進みます。 

②書き込み終えると< Retrieve keyboard successful>のダイアログが表示されます。"OK"

を選択してダイアログを閉じて下さい。設定がソフトウェア上に表示されます。 

 

Ⅳ-2-4. Clear Current Layer 

現在設定画面に表示されている Layer のキーマッピング設定を削除します。他の Layer に

設定されているキーマッピング設定は削除されません。 

 

①メニューバーの{Keyboard -> Clear Current Layer}を選択して下さい。現在表示してい

る Layer のキーマッピング設定が削除されます。 
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Ⅳ-2-5. Clear All 

全キーマッピング設定を削除します。キーボードパラメータ設定は初期化されません。 

 

①メニューバーの{Keyboard -> Clear All}を選択して下さい。キーマッピング設定全てを

削除します。 

 

Ⅲ-2-6. Keyboard settings 

キーボードパラメータ設定を行えます。キーボードパラメータ設定とは、キーリピート設

定、起動時の beep 音設定、キー押下時の beep 音設定など、キー入力情報以外のキーボー

ド設定をすることが出来ます。 

変更した設定を保存する場合は<Save Settings>を選択してください。<Previous Menu>は

瀬体を保存せずに戻ります。このキーボードパラメータ設定をキーボード本体に書き込む

ためには、Ⅳ-2-1. Keyboard - Update Whole Keyboardを実施する必要があります。 

 

大項目 小項目 説明 

① Keyboard 

Delay 
1-30 

キーリピート間隔を 30 段階で調整できます。 

1 が最も早く、30 が最も遅いです。 

② Key 

Repeat 
YES 

キーリピートを ON にします。リピートする間隔は

①の設定が反映されます。 

NO キーリピートを OFF にします。 

③ Beep With 

PowerOn 

YES 電源 ON 時の Beep 音を ON にします。 

NO 電源 ON 時の Beep 音を OFF にします。 

④ Beep 

setting 

Press With Sound キー押下時の Beep 音を ON にします。 

Press Without Sound キー押下時の Beep 音を OFF にします。 

Only Programmed Key 

Beep Enable 

キーマッピング設定されたキーのみ、キー押下時

の Beep 音を ON にします。 

① 

② ③ 

④ 
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Ⅳ-3. Diagnostic 

キーボードの状態を確認、変更が出来ます。 

 

Ⅳ-3-1. Enter Test Mode 

キーを押してキー自体を診断するテストモードがあります。テストモードへ切り替えると、

各キーに予め割り当てられた 16 進数のキーコードが beep 音と共にキーを押されたときに

出力されます。 

 

①メニューバーから{Diagnostic -> Enter Test Mode}を選択して下さい。<setting is 

successful>のダイアログが表示されますので"OK"を選択してダイアログを閉じて下さい。

設定画面上には表示されませんが、キーボードのテストモードが ON の状態になります。 

 

Ⅳ-3-2. Exit Test Mode 

テストモードに切り替わったキーボードは、この Exit Test Mode でテストモードを解除で

きます。 

※テストモードに切り替えたら、必ずテストモードの解除をしてください。解除しないと、

キーボードが正常に動作しないことがあります。 

 

①メニューバーから{Diagnostic -> Exit Test Mode}を選択して下さい。<setting is 

successful>のダイアログが表示されますので"OK"を選択してダイアログを閉じて下さい。

設定画面上には表示されませんが、キーボードのテストモードが OFF の状態になります。 

 

Ⅳ-3-3. Set Default Value 

設定情報を初期化したいときに使用します。全キーマッピング設定とキーボードパラメー

タ設定がデフォルト値に戻ります。 

※キーボード本体と、設定ソフトウェアの両方に初期化をかけます。ご注意ください。 

 

①メニューバーから{Diagnostic -> Set Default Value}を選択して下さい。<Update Key 

Mappings successful>のダイアログが表示されますので"OK"を選択してダイアログを閉じ

て下さい。キーボードと設定ソフトウェアの初期化が完了します。 

 

Ⅳ-3-4. Firmware Version 

設定ソフトウェアのファームウェアバージョンを表示します。 

 

①メニューバーから{Diagnostic -> Firmware Version}を選択して下さい。<The Version 

is>のダイアログが表示されますので"OK"を選択してダイアログを閉じて下さい。 
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Ⅳ-4. Language 

設定ソフトウェアの言語表示の変更ができます。初期値は"English"です。 

 

Ⅳ-4-1. English 

設定ソフトウェアの言語表示を英語に変更できます。 

 

①メニューバーから{Language -> English}を選択して下さい。表示モードが英語になりま

す。  

 

Ⅳ-4-2. Simplified Chinese 

設定ソフトウェアの言語表示を中国語（簡体字）に変更できます。 

※中国語が表示できるパソコン環境にて実施して下さい。文字化けをする場合、中国語を

表示する環境が整っていない可能性があります。 

 

①メニューバーから{Language -> Simplified Chinese}を選択して下さい。表示モードが

中国語（簡体字）になります。  

 

Ⅳ-5. Help 

設定ソフトウェアのバージョンを表示します。 

 

Ⅳ-5-1. About Matrix Maker… 

バージョンを表示します。当該ソフトウェアは"MKB24U"と表示されます。 

 

①メニューバーから{Help -> About Matrix Maker...}を選択して下さい。<MKB24U>のダイ

アログが表示されます。バージョンを確認したら"OK"を選択してダイアログを閉じて下さ

い。  

 



Matrix Maker for MKBJ24U キーボード設定ソフト説明書 

- 43 - 

Ⅴ. よくある質問 
 

Question: 

キーに"Ctrl + Alt + Down"を設定したのですが、上手く動作しません。設定したキーを 2

回押すと反応したりします。 

Answer: 

以下の設定（赤枠）が"Ctrl + Alt + Delete"キーの割り当てコードになります。 

手順 1. 左 Ctrl をクリック(Left Ctrl Down) 

手順 2. 左 Alt をクリック(Left Alt Down) 

手順 3. Delete をクリック 

手順 4. 左 Alt をクリック(Left Alt Up) 

手順 5. 左 Ctrl をクリック(Left Ctrl Up)  

 

 

Question: 

Caps Lock キー、Num Lock キーは接続されている他のキーボードと連動してステイタスが

変化しますでしょうか？ 

Answer: 

Caps Lock キー、Num Lock キーは接続されている PC の OS 設定と連動します。独立して個

別にステイタスは保持しません。 

 

Question: 

キーを押しっぱなしにした際にキーを連続して出力するキーリピートは行なえますか？ 

Answer: 

設定可能です。初期値はキーリピートが OFF になっているので、設定の変更が必要です。 

Ⅲ-2-6. Keyboard settingsを参考にして下さい。 
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Question: 

キーボードのキーを押した時になる"ピッ"音を出すか出さないかの設定は行えますか？ 

Answer: 

設定可能です。初期値はキー押下音が ON になっているので、設定の変更が必要です。 

Ⅲ-2-6. Keyboard settingsを参考にして下さい。 

 

Question: 

キーボードをパソコンに USB 接続した際に”ピー”の音を出すか出さないか設定は行えま

すか？ 

Answer: 

設定可能です。初期値はパワーオン音が OFF になっているので、設定の変更が必要です。 

Ⅲ-2-6. Keyboard settingsを参考にして下さい。 

 

Question: 

常に半角英数として文字列を出力したいのですが、可能ですか？ 

Answer: 

対応しておりません。キーボードは使用している OS の設定に準拠して動作しているため、

常に半角を出力するというのは難しいです。 

 

Question: 

ノートパソコンの[Fn キー]の設定は可能ですか？ 

Answer: 

非対応です。Fn キーは、メーカーによって設定が異なり、そのキーコードの設定内容も特

殊の場合が多いため、当該キーボードのソフトウェアでは非対応とさせていただいており

ます。 

 

Question: 

キー設定で Pause キーの設定後に他のキーを設定しようとすると、ポップアップが表示さ

れて pause 以降の設定ができません。 

Answer: 

製品の仕様です。pause キーは特殊なキーで、pause 後に他のキー入力を想定しされていな

いため、pause 以降はキー設定ができません。 
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Ⅵ. 保証事項 

Ⅵ-1. 保証期間 

・保証期間は納品日より１年間とします。但し、外観に関するキズ等による不具合は 

納品日より１ヶ月とします。 

・保証期間内に正常な使用状態に於いて故障した場合は製品解析を行い、弊社起因に 

よる不良と判断された場合にのみ交換または修理を致します。 

 

Ⅵ-2. 保証対象 

・保証対象は納入品のみを対象とします。納入品の故障により誘発される損害は対象 

とされません。また、現地における製品修理・交換は行いません。 

・納期延停や不具合による対応はできる限り敏速に対応しますが、生産ラインの保証 

や損害は致し兼ねます。 

 

Ⅵ-3. 有償保証 

・保証期間を過ぎた製品は有償での保証と致します。 

・以下の場合は保証期間内におきましても有償保証となります。 

① 取扱不 備によ る落下等 の衝撃 により 生じた故 障  

② 天災、 火災に より生じ た故障  

③ 製品が 組み込 まれてい る (または 接続さ れてい る )他部品 や機器 に起因 して生 じた故 障  

④ 改造・ 分解に より生じ た故障  

⑤ コーヒ ーやジ ュース等 水分の 浸入に より生じ た故障  

 

Ⅵ-4. 仕様変更 

・キーボードは標準品の為、機能に影響を及ぼさない範囲で事前告知無く仕様を変更 

する場合が御座います。 
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